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About this course



Student Notes:



Objectives of the course Upon completion of this course, you will be able to: - Create an interactive view and draw a sketch on it - Insert annotations to dress-up the views - Use advanced dimensioning tools You will also be introduced to the 2D-3D links management and to the drafting workbench customization



Targeted audience Draftsmen
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Prerequisites Students attending this course should be familiar with the basics of 2D views creation in CATIA V5
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Table of Contents (1/2) Introduction to Drafting Workbench Generative Drafting Presentation Drafting: General Process Accessing the Workbench Drafting Toolbars and Objects Drafting Terminology



Creating Interactive Views Starting an Interactive Drawing Drawing the Views Adding Projection Views Methods and Recommendations To Sum Up
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Dressing Up the Layout Adding Annotations and Text Creating Tables Graphic Dress-up Instantiating Elements From a Catalog Methods and Recommendations
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Table of Contents (2/2) To Sum Up



View and Sheet Management Sheets Management Views Management To Sum Up
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Customizing the Drafting Workbench
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Introduction to Drafting Workbench
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You will get familiar with the Generative Drafting Workbench.
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Generative Drafting Presentation
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The Drafting workbench allows you to automatically generate engineering drawings from CATIA Part and Assembly documents.



Engineering drawings generated using this workbench are associative, i. e. any change in the geometry of original Part or Assembly will be reflected in the drawings. You can generate associative dimensions on these drawings. You can use company standard templates to generate the drawings, and also you can dressup the drawings with annotations consistent with the company standards.
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Drafting: General Process



Source Document



Drafting



Part Document Created using Part Design workbench



Product Document created using Assembly Design workbench



Generative Drafting



Generate Views



Dimension



Interactive Drafting Non Associative Annotations
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Design Changes If the part or product changes, the drawing will be updated, to take into account design changes.



Drafting workbench contains the tools to create views, dimension the views and also the interactive tools to create annotations, company templates.
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Accessing the Workbench You can access the Drafting workbench from 1- Start menu 2- File menu 3- Workbench icon 1
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2



3
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Drafting Toolbars and Objects Each toolbar contains objects related to specific tasks. Icons within these toolbars are compressed and can be expanded for accessing additional functionalities. Dimension properties



Text properties



Graphic properties



1



2 11-



3



2233-



4



44-
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7788-
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Drafting Terminology Specifications Tree



Active view (underlined in the tree and with a red frame)



View Frame



Views Grid
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View Name and View Scale



Prompt zone
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Creating Interactive Views Drawing views use sketcher tools to create 2D views. Unlike a Generated view, these views have no link to a 3D model.
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Starting an Interactive Drawing Drawing the Views Adding Projection Views Methods and Recommendations To Sum Up
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Starting an Interactive Drawing
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You will learn how to create front view in Interactive Drafting.
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Why Interactive Drafting Interactive Drafting is a drafting system that can be used in a standalone 2D CAD environment. It can be used for traditional drafting purpose i. e. for creating 2D drawings of the components for which you do not have 3D models.



Simple 2D drawings can be created in Interactive drafting without a 3D model. These drawings can be used to express design ideas.
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ANNOTATIONS



TABLE



NOTES
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To complete a generative view with interactive elements. 2D interactive functionalities can be used in an advanced production environment for the dress-up and annotation of drawings.



Detail Drafting Student Notes:



Starting the Front View When a drawing is created, you need to add a front view before starting to draw lines. 1



3



Select the New View icon.



2



Place the view by clicking on the sheet



The Front view is added in the tree and on the Sheet with a blue HV reference axis and a view frame
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View frame : By default, a view frame is displayed and always fits the content of the view and changes with it.
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Drawing the Views
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You will create basic sketches within the Drafting workbench
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Sketching ... Sketching in the drafting workbench gives you the ability to create 2D shapes. A sketch is a rough drawing by nature however it is possible to create precise elements. A typical approach to sketching is made up of three steps: Profile Creation Creating Sketch Constraints Editing Constraints



Copyright DASSAULT SYSTEMES



When first creating a sketch thought should be given to the basic shape of the profile and not precise measurements. Once the profile is created, constraints can be added to help better define the profile. Finally, by editing the applied constraints, the precise profile can be obtained.
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Profile Creation Sketches drawn with the profile icon help to eliminate the need for the creation of multiple sketched entities such as line, curve and trim. Profiles do not need to be created precisely which speeds up sketching. 1



Select the Profile icon



4



Click to create angle (A) and click again to create a horizontal line (B). Blue indicates horizontal.



(B)



(A)



5
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6
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Enter values for the First Point, Length and Angle.



2



3



Enter values L: 50mm & A: 90deg



Select the Tangent Arc icon



Example results :



(2)



Click to create the arc when it is inline with the vertical axis.



(a)



7



Click on the origin to close the profile.
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Point Creation Point types available in the Drafting Workbench:
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Type



Icon



Description



Points by Clicking



Create a point just clicking where you want it to be.



Points by Coordinates



Create a point defining its coordinates in the 2D space of the Sketch.



Equidistant Points



Create as many points as you want equidistantly distributed on an existing curve.



Intersection Point



Create the intersection point between two existing curves.



Projection Point



Project an existing point onto an existing curve normally to this curve.
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Line Creation Line types available in the Drafting Workbench:
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Type



Icon



Geometry



Description



Line



Create a line by clicking two points to define its extremities.



Infinite Line



Create an infinite line defining its direction by clicking two points.



Bi-tangent Line



Create a line tangent to two existing curves.



Bisecting Line



Create a line bisecting to two existing lines.



Line Normal to Curve



Create a line perpendicular to an element.
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Circle Creation (1/2) Circle and Ellipse types available in the Drafting Workbench:
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Type



Icon



Geometry



Description



Circle



Create a circle defining its center and its radius by clicking.



Three Points Circle



Create a point passing by three points.



Circle by Coordinates



Create a circle giving the coordinates of its center and its radius.



Tri-tangent Circle



Create a circle tangent to three existing curves.
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Circle Creation (2/2) Circle and Ellipse types available in the Drafting Workbench:



Type



Icon



Geometry



Description



Three Points Arc



Create an arc passing by three points, relimited by the first and the last selected points.



Three points arc starting with limits



Create an arc passing by three points, relimited by the first and the second selected points.



Arc
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Ellipse
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Create an arc defining its center and the two limit points.



Create an ellipse by selecting its center point, and defining its dimensions by clicking two points.
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Curve Creation (1/3) Curve types available in the Drafting Workbench:



Type



Icon



Geometry



Description



Spline 1



2



3



4



5



Connect



Create a spline curve passing by as many points as you want. End the spline by doubleclicking. Create an arc connecting two curves.



1



2



3



4



Start with two curves
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Parabola by Focus 1



2



Focus and summit selection



Copyright DASSAULT SYSTEMES



3



4



Relimiting points selection



Create a Parabola selecting: • The focus point • The summit • The relimiting points
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Curve Creation (2/3) Curve types available in the Drafting Workbench:



Type



Icon



Geometry



Hyperbola by focus
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1 2 3 4 5 Focus and center selection Summit and relimiting points selection
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Description Hyperbola by focus • Create an Hyperbola selecting: • The focus and center points • The summit • The relimiting points
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Curve Creation (3/3) . Conic: Conics can be created in several ways. After the ICON is selected, several conic tools appear in the toolbar shown.



Description



Geometry



Icon Two point conic with end tangents



2



4



5 1



3



Two point conic with tangent intersection



Select two end points, select a point which defines the tangent intersection, select a mid point.



3 4 1



2 2



Four point conic with one tangent



5 4
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1



Five point conic
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3 5



1



Select an end point, define its tangency, select the other end point and its tangency, select a mid point



4



Select the two end points, select two mid points, define one tangency at first or last point. Select two end points, select three mid points.



3 2
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Relimitation Elements (1/2) Relimitation types available in the Drafting Workbench:
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Type



Icon



Geometry



Description



Corner



Trims two elements to create a round corner. Option available to keep existing edges or to trim them.



Chamfer



Creates a beveled corner at the point where two selected edges meet. Option available to keep existing edges or to trim them.



Trim



Trims or extends elements to form a closed corner. Select elements on the side of the intersection you want to keep.



Break



Divides an element at selected point. Creates two elements from one.
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Relimitation Elements (2/2) Relimitation types available in the Drafting Workbench:



Type



Icon



Geometry



Description Trims the selected element to the intersection of another element.



Close



Connects the endpoints of the element to close it.



Complement



Replaces the existing element with an element that would close the original.
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Quick Trim
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Transformation Elements (1/2) Transformation types available in the Drafting Workbench:



Type



Icon



Mirror



Translate
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Symmetry
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Geometry



Description Creates mirror image of selected elements about a selected line or axis Moves selected elements in the X and/or Y direction. Can also be set to duplicate mode.



Moves selected elements about a selected line or axis
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Transformation Elements (2/2) Transformation types available in the Drafting Workbench:



Type



Icon



Geometry



Description Rotates selected elements. Can also be set to duplicate mode.



Scale



Enlarges or shrinks selected elements by a ratio of the original.



Offset



Offsets just the selected element. Can also be set to offset all elements connected to the selected element.
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Rotate
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Creating Sketch Constraints A sketch can be constrained using geometrical constraints, such as tangency, to establish geometrical relationship. 1



Select the elements to constrain.



2



Select the “Constraint Defined in Dialog Box” icon. Select the Type of geometrical constraint in Constraint Definition dialog box.



(B) Select the vertical line A and arc B



(A)



Select Tangency.



Or the sketch can be constrained by creating controlling dimensions which can be edited.
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3



(C)



Select Dimensions icon and the elements to constrain and indicate the location.



(A) Length of lower horizontal line (B) Distance between horizontal lines (C) Radius (D) Angle of chamfer relative to vertical (E) Distance of chamfer width relative to right side of profile and chamfer point
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(D)



(B)



(A)



(E)
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Creating Explicit Geometrical Constraints Explicit Geometric Constraints can be created between sketched elements or between sketched and generated geometry. 1
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3



Select the Geometric Constraint icon.



Using the contextual menu, select the Geometric Constraint.



2



Select the elements to Constrain.



A predetermined Geometric Constraint will be displayed. If this is the desired constraint, select the drawing background to confirm.



It is impossible to create a constraint between sketched and generated geometry through the Constraints Definition dialog box. Use this method to create a constraint between sketched and generated geometry.
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Adding Projection Views
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You will create additional projection views on a drawing.
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What is the General Method to Add Views ? Added Views are usually created as projections of the Front view. The New View icon is used the create projection views one at a time. When an existing view is active, added views are created as projections of that view based on 1st or 3rd Angle Projection. Any view that is made active becomes the primary view, and added views that are created become a projection of this primary view.
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Projection from a Front View is a Bottom View based on 1st Angle Projection
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Projection from a Bottom View Results in a Rear View based on 1st Angle Projection
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Adding Views The views added on the drawing are projected from the active view in accordance with the selected standard 1



Select the new view icon



2



Place the view by positioning the cursor according to the desired View; for example: - in ISO, above the Front view will give a Bottom view - in ANSI, above the Front view will give a Top view
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3
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Select on sheet to create the view



ISO
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Construction Lines To easily draw the lines in the views, you can use the construction lines. Construction lines are projections of the lines of one view into the active view and can be used to draw lines. Activate the view in which you want to receive the construction lines by double-clicking on its frame or on its name in the specification tree
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1
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2



Place cursor on the view frame from which you want to get the construction lines. Then, using the third mouse button, select Show Folding Lines from the contextual menu
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Create Geometry using Construction Lines When construction geometry is present, Auto Detection recognizes it to anchor newly created geometry. 1



3



Select the Rectangle icon.



2



Select the left construction line using auto detection to begin the rectangle.



Select the right construction line using auto detection to complete the rectangle.
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4



Copyright DASSAULT SYSTEMES



Select the line icon. Then use the intersections of the construction line and the rectangle to complete the line.
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Creating a Multiple View Projection (1/2) This function allows you to generate geometry in a view by projecting geometry from previously defined views. The projected geometry retains the same attributes it had in the original multi-view. Activate the view where you want the projection to appear.
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1
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2



Select the Multiple View Projection icon.
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Creating a Multiple View Projection (2/2) 3



Select object defining target plane or surface



4



Select one by one the geometry elements (four) which compose the feature (elongated hole). The result appears automatically



The result
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Two lines and two arcs
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Methods and Recommendations
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You will see some suggestions and techniques you can use while creating interactive views. Also, you will learn how to complete the generated drawing using interactive elements.
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Sketching Aids (1/2)
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There are several sketching aids available in menu Tools >Options > Drafting in the General and Geometry tabs.



Using these aids will minimize the need to Edit Constraints to make the sketch precise.
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Sketching Aids (2/2) Make use of construction lines and transformation tools to increase your efficiency. Use construction lines to ensure projection views are in line with the main view. Construction lines.



Take advantage of the transformation tools available to help increase your efficiency while constructing similar or identical geometry.
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Mirror



Rotate



Create the approximate profile first and then use constraints to make the sketch more precise.
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Initial Sketch



Final Sketch
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Completing a Generative View 2D interactive functionalities can be used in an advanced production environment for the dress-up and annotation of drawings.



ANNOTATIONS



In case of larger assemblies absolute positioning can be drawn on the drawing.



ABSOLUTE POSITIONING LINES
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TABLE



NOTES



Information related to manufacturing can be added in the form of notes view.
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Annotations can be used to define geometrical tolerances



Precise positions of key points can be given in Table Format.
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To Sum Up You have learned: How to create interactive views. How to use sketcher tools to create geometry. Remember, a typical approach to sketching consists of three steps: Creating Profiles Creating sketch constraints Editing constraints
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Dressing Up the Layout To fully detail a drawing it is often necessary to add additional information such as geometric tolerancing, notes, or tables. In this lesson we will look at how to create these.



Copyright DASSAULT SYSTEMES



Adding Annotations and Text Creating Tables Graphic Dress-up Instantiating Elements From a Catalog Methods and Recommendations To Sum Up
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Adding Annotations and Text
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You will learn how to add symbols geometrical tolerances and text to the drawing.
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Symbols You can add symbols to better define the specifications of the part.



Type



Icon



Geometry



Description Creates a standard roughness symbol including roughness value, direction of lay, production method etc.



Welding Symbol



Creates a weld symbol including complimentary symbols and weld finish symbols.



Weld



Creates a geometry weld symbol between two elements.
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Roughness Symbol
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Geometrical Tolerances You can add symbols to better define the specifications of the part



Type



Icon



Geometrical Tolerance



Datum Feature
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Datum Target
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Geometry



Description Creates standard geometrical tolerances including symbols and references.



Annotates a Datum Feature.



Annotates a datum target.
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Creating Text



Text can be created with or without leaders and can have many properties to customize the font and frame style (shown on the right).
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Special symbols can also be inserted into the Text as needed.
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Text without Leader Text without leaders with a customize symbol and frame style. 1



3



Select the Text icon to create text without a leader



2



Select the text anchor (starting) point



Key the desired text with the appropriate framing or embedded symbols; for example: (a) Key “HOLE” then spacebar (b) Select from the Symbol icon then press
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spacebar (c) Key “SIZE 3” then press ENTER to start new line (d) Key “SEE NOTE” then press spacebar (e) Select from the Frame icon (f) Key “1”.



4



Select anywhere to end the text.
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Example results:
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Text with Leader Here is how to create text with leaders:



Select the Text with Leader icon



3



Select the text anchor point



4



Key desired text (ITEM 4)



5



Click anywhere to end the leader text
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1
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2



Select an anchor point for the arrow head



Example results:
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Non-Associative Balloons 1



Select the Balloon icon



2



Select an anchor point for the arrow head



3



Select location for the balloon



Example results:



Copyright DASSAULT SYSTEMES



4



Key desired text (2)
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Editing Text Text can be modified to change leader style the content, style or the orientation of the text.



Add breakpoints and create multiple leaders
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Change arrow style
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Change text orientation



Change Text font or justification
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Text Manipulation Text can be manipulated in the following ways: Edited, Repositioned and/or Leaders added or removed 1



Double click text to open the Text Editor.



2



Swipe the cursor across the text (second line) within the Text Editor window and edit or delete. Select any part of a note and drag to reposition it



3 4



To add a leader; Right click the note and select: Indicate or select an element to anchor the arrow head.
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This process can be repeated to create multiple leaders.



5



Select the anchor point of a leader arrow and drag it to reposition it



6



Right click on the anchor point of the leader arrow, select the option from the contextual menu
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Text Properties Text font and justification can be modified through the properties dialog box or the Text Properties toolbar. 1a



Right click on the note and select Properties from the contextual menu.



2a



Make necessary changes.



1b Highlight the note.



Use the Text Properties toolbar
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2b to make changes.



3



Click OK to complete the change.
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Text with Breakpoints and Multiple Leaders Here is how to create text with multiple leaders and breakpoints. Add Breakpoint: 1



Select the Text with Leader



2



Using the contextual menu, Select the anchor point (yellow symbol) and Add a Breakpoint item.



2



Select an element or location to end the leader



3



Select the breakpoint and drag to desired location



Add Leader: Using the contextual menu, select a breakpoint and the Add an Extremity item.



Copyright DASSAULT SYSTEMES



1
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Example result:
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Associated Text Define a link to 2D geometry to determine the orientation of text 1



Right click on the text



2



Select option Orientation Link and Create



3 Select orientation element
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As the element rotates, the text will flip to avoid being backwards or upside down unless the text property Auto Flip is disabled
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Creating Tables
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You will add a Table to a drawing and modify it
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Tables Tables are used to capture drawing information in tabular form. Typically tables are used to handle title block information or bill of materials.
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Tables can be created each time or they can be created in another program saved as a CSV file and imported into one or many drawings.
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Creating a Table To create a Table of data for Bill of Material list, Revision Notes, or etc... Select the key Table icon



3



Key the number of columns and rows for the Table



4



Double click the Table to select it.
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1
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2



5



Select the Table location



Double click a Table cell to edit it.



Continue step 5 to fill in all necessary cells.
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Creating a Table from a csv file
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To create a Table of data from a csv file for Bill of Material list, Revision Notes, or etc... 1



Select the key Table icon



2



Select the csv file



3



Select a location for the Table



A CSV file is a text file that is comma delimited. To create a CSV file: save the file created in another program as a .csv file.
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Editing a Table To edit a Table element to add or delete rows and columns, resize the rows or columns, and invert the rows or columns. 1



Double click a Table cell to edit , Use the contextual menu to select the item to modify or select a row/column marker to resize.
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2



Double click the Table to select it
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Splitting Tables A table can be split if it becomes larger than a given number of rows 1



Right click on the table and select Split Table from the contextual menu 2



Enter in the Split Criteria



Tick box if the first row of the original table is to be copied to the split tables



Example results: 3
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Select the OK button to complete
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Enter number of rows the table can have before it splits or the maximum height before the split



Enter distance between the split tables
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Graphic Dress-up
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You will learn how to apply dress-up such as centerlines threaded representation and patterns to a drawing.
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Center Lines Centerlines for various applications are available in the Insert >Dress-up > Axis and Threads menu. Centerlines can be resized after the creation.



Select the Center Line icon



2



Select the circle
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1
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1



Select the Axis Line icon



2



Select two reference lines to fit the axis line between.
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Adding a Pattern on a Section To draw a section cut, you need to add a sectioning symbol to represent the material. You can choose between several types of symbols in a Pattern Table. 1



Select the Area Fill icon



3
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2



Select automatic Area detection.



The”With Profile Selection” option allows you to manually define the area to be filled
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Select in the zone to fill
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Changing Hatching Pattern (1/2) 1



Select the hatching pattern to modify. Select the properties using the right mouse button.
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Note the different types of Patterns that can be selected from the pulldown



Copyright DASSAULT SYSTEMES



2



Modify the current patterns attributes or select a new type of pattern from the type pull-down



3



Click the button to browse to access the Pattern Chooser dialog box. (Discussed on the next Foil)
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Changing Hatching Pattern (2/2) 3



Select the to open the pattern Chooser.



4



Choose the Pattern type and Select OK to return to the Properties window.



5



Change the attributes of the new pattern type if necessary and select the OK button to update the pattern
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The pattern is changed on the section.
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Instantiating Elements From a Catalog
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You will learn how to instantiate a 2D elements from a catalog and how to synchronize links between CATDrawing and the catalog file.
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Why Instantiate a Component From a Catalog A 2D component is a re-usable set of geometry and annotations. This component is stored in a CATDrawing referred by the catalog. The 2D component can be instantiated several times, each instance providing a component with a specific orientation, position and scale.



2D component stored in a CATDrawing
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Instances of 2D component.



Link is maintained between the Instances and the original 2D component. You can update the instances to reflect the changes made in original 2D component.
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How to Instantiate a 2D Component From a Catalog (1/2) You can multi-instantiate a 2D component from catalog, reorient the component and explode them at the time of instantiating. 1



2



Activate the view in which you want to instantiate the 2D component and select Catalog Browser icon.



Open the source catalog file, using Browse another catalog tool.



Catalog Browser dialog box gives you list of the chapters in the catalog file.
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3



Double click on the chapter in which required 2D component is placed.



4



Select the 2D component you want to instantiate.
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Preview of the component will be displayed.
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How to Instantiate a 2D Component From a Catalog (2/2) 5



Drag the component from Catalog Browser into the drawing window, and select the points where you want to instantiate.



7



Click on the empty space in the sheet to exit the command.
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6



Set the Angle and Scale values
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How to Synchronize the Links



Student Notes:



When a original 2D component is modified, you need to synchronize the link between the 2D component and the instance to reflect the changes made in original 2D component. Select Edit > Links.



3



Select OK inside the Links dialog box.
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1
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2



In the Links dialog box select the MML link between the 2D Component and the instance, select Synchronize.



The instance is modified as per the changes in the original 2D component.
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Methods and Recommendations
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You will learn about notes view, attribute links and links of a 2D component instance.
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Using a Notes View for Text and Table
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A note view is used to add the notes in the drawing. A Note View is a stand alone view that is not projected from an existing View. Create a front view and rename it to “Notes View” and then add notes to this view.
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Adding an Attribute Link To create an attribute link in a note or table cell use the same technique 1



Double click on the text you want to add the link to



4



2



Right click and select Attribute Link from the contextual menu



Select the object you want the text to link to



Select the attribute from the list and click the OK button to complete 5
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3



Example results:



An attribute link will update when changes are made in the parameter it is linked to, provided the Automatic Update mode is turned on in the Options > Mechanical Design > Part Design > General Tab
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Links to the Catalog When a 2D component is instantiated from a catalog a link is created between the 2D component instance and the CATDrawing file which is used to create the catalog. Link



2D component stored in a CATDrawing Catalog



Instances of 2D component.
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You can break the link between the original 2D component and the instance, using Explode 2D component command available in contextual menu.
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To Sum Up You have learned how to: Add symbols to a drawing Select the appropriate symbol from the Symbol toolbar Add Tolerance Use the Dimension Properties toolbar for quick access to tolerance Create GD&T symbols Use the Tolerancing Toolbar Create text Use the Annotation toolbar Create a table
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View and Sheet Management It is sometimes necessary to modify sheets and views properties to improve layout to better suit the needs of a particular drawing.
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Sheets Management Views Management To Sum Up
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Sheets Management
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You will learn how to add a new sheet to a drawing, and how to change the properties of a sheet.
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Why Add Sheets to a Drawing? Sheets are added to a drawing to improve clarity and manage views or annotations that are cluttering a single sheet drawing.
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Sheet 1 of 2
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Sheet 2 of 2
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Adding a Sheet to a Drawing
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1 Select the New Sheet icon It creates an empty sheet with the next sheet number (Sheet 2)



The new sheet is assigned the same standard, format and orientation as the first created sheet
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Why Change Sheet Properties?
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There are times when one or more sheets in a drawing may require properties that are different from the rest of the drawing sheets. By accessing Sheet Properties you can customize individual sheets.
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Sheet Properties 1



Modify the sheet name, the scale, the format (ANSI or ISO) or the projection method (first angle or third angle).
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2



Select the Sheet in the tree and Properties in the contextual menu to change its properties.
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Views Management
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You will learn how to reposition views on a single sheet and how to move views from one sheet to another sheet.
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Relative Positioning A view can be positioned at an exact position on a Sheet and relatively to another view already on the sheet. Here view B is positioned relatively to view A



View A



Geometric center of view



Positioning stick showing distance



Middle top anchor point
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View B



This is often used for isometric views, and particularly for exploded views of assemblies
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Repositioning a View with Relative Positioning (1/3) 1



Select « View Positioning » then « Set Relative Position » in the contextual menu A positioning stick appears with anchor points around the view and in its center



Positioning Stick Anchors points The stick has 3 handles: - the green end - the stick - the black end
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By default, the green handle is on the center anchor point and the stick is oriented SW (south-west).
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Remember the contextual menu can be accessed from the tree structure or the view frame. Therefore, the view frame does not need to be on to use the relative positioning option.
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Repositioning a View with Relative Positioning (2/3) 2



There are 4 ways to move a view with the positioning stick You need to combine these to position the view



(A) Selecting the Stick



Stick length and distances values appear. Drag along the stick to make it shorter or longer: the view moves accordingly.
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(B) Selecting the black end and another view frame



The black end snaps on the center of the selected view frame and the view follows
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Repositioning a View with Relative Positioning (3/3)



(C) Selecting the green handle Drag to rotate the view around the black end
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(D ) Selecting another anchor point



The green end moves to the selected anchor point and the view is moved (ex. here bottom middle anchor was selected; view moved up)
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Moving Views from one Sheet to Another Sheet A view can be moved from one sheet in a drawing to another. This can be useful when a sheet becomes too cluttered. 1



Cut the view on the sheet to be moved.



2



Paste the cut view on the desired sheet in the specification tree.
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Contextual Menu
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Sheet 1



Sheet 2
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Reordering Views in the Specification Tree
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You can organize your specification tree by using reorder command. The children views can be arranged after the parent view.
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1



Select the views you want to reorder and launch reorder command from contextual menu.



2



Select the view after which you want to place the reordered views.



Section view A-A, Detail D and Section view B-B reordered after the front view In the same way, you can reorder the sheets also.
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Modifying Graphical Definition for Views
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According to your or your customer’s needs, CATIA allows you to modify the graphical attributes of Section, Detail or Auxiliary views. 1



Select the view callout and select Properties with the contextual menu.



2



Select the Callout tab. Use the different commands to customize the drawing. Switches for predefined types of lines



3



Select Ok.
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Customize the arrows
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Preview Customize the line, the extremities and the anchor point



Detail Drafting



How to Restore the Graphical Definition? You can restore the deleted graphical definitions of section views, auxiliary views and detail views. 1



Right click on the section view and select Section view XX object > Add Callout



2



Select the parent view
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Graphical representation of the section view restored in its parent view.
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To Sum Up In this lesson you have learned: How How How How How How



to add additional sheets. to modify sheet properties. to edit the properties of a sheet. to reposition the views. to move a view from one sheet to another. to modify graphical definition for views.
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Customizing the Drafting Workbench In this lesson we will look at options available to you to customize the Drafting workbench.
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Drawing Customization Options Setting Drafting options Standard Management To Sum Up
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Drawing Customization Options The options shown in this course are just some of the numerous options available to customize the Drafting workbench.
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The options that will not be discussed in this course are typically controlled by an administrator and not a user.
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Detail Drafting



Setting Drafting Options
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You will learn how to set the session’s default drafting options
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Detail Drafting Student Notes:



What are Drafting Options? (1/2) There are primarily nine Drafting Option tabs that allow the user to customize the drafting interface. 1.



General - Determine display of ruler, grid, background colors and tree display



2.



Layout - Determine display of view name, scale, frame and determines new sheet parameters settings



3.



View – Determines the display of geometry and view generation



4.



Generation - Determines dimension and geometry generation



5.



Geometry - Aids to create geometry such as display of center points, autodetection for orientation, and constraint creation and display



6.



Dimension - Position, Line-up dimensions and Analysis display mode



7.



Manipulators – Turns on / Off the manipulators for dimension creation or modification
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2



3



4



5



6



7
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What are Drafting Options? (2/2)



8.



Annotation and Dress-Up – Turns on/off the controls for annotations



9.



Administration – Controls for administrator
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General Options (1/2) Set the following General options: 1



Show Ruler: In the OFF position the ruler along the top and left side of the screen will not be displayed.



1



2 3
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2



Grid: With the Display turned ON and Snap to point turned ON. Adjust the Primary spacing and graduations to aid in dimension placement.



Snap to Point and grid display can also be controlled from the toolbars.
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3



Allow distortions: Allow you to change the scale of H and V on the grid.



Detail Drafting Student Notes:



General Options (2/2) Set the following Display options: Colors: Change colors of the sheet and detail background.



2



Tree :Display parameters and relations in the specification tree.



3



View Axis: Provides a blue axis in the view that is current.



4



Start Workbench: ‘New’ dialog box when starting the drafting workbench.
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2 3
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Layout Options Set the following view Layout options: 1) View name: Check that it is OFF since primary and projected view names are not normally necessary. 2) Scaling factor: Check that it is OFF since primary and projected view scale will be declared on the drawing as a global scale for the drawing. 3) View frame: Turn on to easily understand which view is active and to quickly access view properties. 4) Propagation of broken and breakout specifications: Allows the propagation a Broken or Break-out specification during the creation of a projection or auxiliary view. 5) Auxiliary and/or section views orientation according to profile: Allow the view axis to be orientation according to profile6) New Sheet : Allows the selection to determine where the sheet properties will be copied from and an option to copy the background view.



1 2
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Generation Options Set the following view Generation options:
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Dimension Generation: Allows dimensions to be automatically positioned after generation,automatic transfer between views and analysis of dimensions that have been generated



Time delay between dimension generation when using the step by step method can also be set prior to starting the generation process.
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Detail Drafting Student Notes:



Geometry Options Set the following view Geometry options:



1



1) Geometry: Interactive geometry creates circle and ellipse centers and end points included with drag elements 2) Smart Pick: Provides an aid for creating geometry relative to existing features and geometry 3) Constraint Display: Allows what constraints will be visualized and the constraints color and size



2



3



4) Colors: Allows you to visualize and choose colors for geometry elements
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Dimension Options Before creating any dimensions, turn on the following Dimension options: 1.Manual positioning at creation: allows full freedom for dimension positioning.



1



2.Associativity on 3D : a link can be applied between a dimension and the 3D part. As a result, when you update the drawing, the dimension is automatically re-computed. If you do not check this option, when you perform the update, you need to recreate the dimension afterwards.



2
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3.Line-Up default: a default spacing between dimensions when a LineUp and a reference dimension are selected 4.Activate analysis display mode: Displays dimension status of Non up-to-date dimensions, Non associative dimensions, converted dimensions, Fake dimensions, Driving dimensions and True dimensions
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4



103



Detail Drafting Student Notes:



Manipulators Options Option to enable dimension manipulators to control the precise location or properties during creation or modification of dimensions



5



6



7 4



3 1



1



2



2 3 4 5 6



1a
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Annotation Options Options to enable SNAPPING to control the precise location or properties of text, leader text, or GDT during creation or modification
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Annotation Options for Text, Leader Text, and GD&T 1. Settings to choose the leader default behavior 2. Stay Horizontal/Vertical with leader creation 3. Free orientation Ability to Swap the text or GDT orientation during creation 1. With the Ctrl key, swap from vertical to horizontal 2. With the Shift key, free or lock perpendicular the leader
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Standard Management.
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You will learn about customizing the drafting standards.
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Why Standards? Drafting standards are used to have uniformity in the drawings created. All Draftsmen referring to the same standards, ensures the uniformity in the graphic conventions drawings. Administrator can set the standards complying to the specific organization. These standards govern the different parameters of the drawing elements such as Angle of Projection of the views, dimension style, line types and many more.



Dimension in ANSI standard.



Dimension in ISO standard.
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Administrator can create company specific standard files and draftsmen will use these standards while creating new drawings.



To maintain integrity of the standards only administrator can change the standards. Following slides will tell how Administrator can change the standards.
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Accessing the Standards
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Standards are stored in a xml file. Administrator can edit these files using an



interactive editor. 1



Select Tools > Standards menu.



2



Select drafting Category and select the respective standard file.
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This editor provides an easy-to-use graphic interface to customize the parameters included in the standard files.



Save the changes made in the standards in a new xml file. To modify the standards you need to start the CATIA in Administration mode.
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Standards Content Standard file contains several main sections, each dealing with a specific aspect of drafting customization. Following are few important sections. Styles: Administrators can set the default values that will be applied to all properties of the elements such as sheets, geometry, annotations, dimensions, dress-up and dress-up symbols etc. General: Administrator can control and restrict the values that are available for some element properties e.g. Text fonts used by draftsmen can be controlled using this property. Dress-Up: Administrator can control the appearance of Dress-Up parameters such as threads and markup arrows. Dimensions: Using this node administrator can control the appearance of Dimensions e. g. appearance dimension value.
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Tolerance Format: The tolerance format parameters drive the representation of a dimension tolerance, and include parameters such as type of tolerance, font size for tolerance etc.
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View Generation: This node lets administrator customize settings that should be applied when generating views in a Generative Drafting context. Frames: Frames around text and annotations can be customized using this node. Line Types: Line types applied to the elements in a drawing, such as lines, curves, dimension lines etc. can be customized using this node.



Detail Drafting



Taking Into Account Standard Modification When draftsmen create a CATDrawing document they specify the standard that will be associated with this document. The values of the parameters in the specified standard file are then copied into the CATDrawing document. When Administrator modifies a standard file, updated standards will be applied to the new drawings created afterwards.
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To take in account these modifications in previously created files, you have to open them and reapply new standard using File > Page Setup command.
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To Sum Up You have learned: How to customize the CATIA Drafting workbench Options to customize the drafting workbench. How standards are used to bring in uniformity in the drawings How to modify the standards
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